
Extracted from:

Mac Kung Fu
Over 400 Tips, Tricks,

Hints, and Hacks
for Apple OS X

This PDF file contains pages extracted from Mac Kung Fu, published by the
Pragmatic Bookshelf. For more information or to purchase a paperback or PDF

copy, please visit http://www.pragprog.com.

Note: This extract contains some colored text (particularly in code listing). This
is available only in online versions of the books. The printed versions are black
and white. Pagination might vary between the online and printer versions; the

content is otherwise identical.

Copyright © 2012 The Pragmatic Programmers, LLC.

All rights reserved.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted,
in any form, or by any means, electronic, mechanical, photocopying, recording, or otherwise,

without the prior consent of the publisher.

The Pragmatic Bookshelf
Dallas, Texas • Raleigh, North Carolina

http://www.pragprog.com




Mac Kung Fu
Over 400 Tips, Tricks,

Hints, and Hacks
for Apple OS X

Keir Thomas

The Pragmatic Bookshelf
Dallas, Texas • Raleigh, North Carolina



Many of the designations used by manufacturers and sellers to distinguish their products
are claimed as trademarks. Where those designations appear in this book, and The Pragmatic
Programmers, LLC was aware of a trademark claim, the designations have been printed in
initial capital letters or in all capitals. The Pragmatic Starter Kit, The Pragmatic Programmer,
Pragmatic Programming, Pragmatic Bookshelf, PragProg and the linking g device are trade-
marks of The Pragmatic Programmers, LLC.

Every precaution was taken in the preparation of this book. However, the publisher assumes
no responsibility for errors or omissions, or for damages that may result from the use of
information (including program listings) contained herein.

Our Pragmatic courses, workshops, and other products can help you and your team create
better software and have more fun. For more information, as well as the latest Pragmatic
titles, please visit us at http://pragprog.com.

The team that produced this book includes:

Jackie Carter (editor)
Potomac Indexing, LLC (indexer)
Kim Wimpsett (copyeditor)
David J Kelly (typesetter)
Janet Furlow (producer)
Juliet Benda (rights)
Ellie Callahan (support)

Copyright © 2012 The Pragmatic Programmers, LLC.
All rights reserved.

No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form, or by any means, electronic, mechanical, photocopying,
recording, or otherwise, without the prior consent of the publisher.

Printed in the United States of America.
ISBN-13: 978-1-937785-07-9
Encoded using the finest acid-free high-entropy binary digits.
Book version: P1.0—November 2012

http://pragprog.com


Tip 1

Make Launchpad Bigger (or Smaller)

By default, Launchpad displays your app icons in a grid that’s usually 5x8
icons in size.

By reducing or increasing the size of this grid, which can be achieved by
adjusting a few secret settings, the icons will increase or decrease in size to
fill the space, allowing you to fit more of them in (or fewer!).

However, if the icons increase in size, this will mean more pages of icons
within Launchpad because fewer app icons will now be able to fit on each
page. Accordingly, decreasing the size of icon grid will mean more can fit on
a page.

There’s another side effect too—the number of apps icons that can fit within
a Launchpad folder is defined by the grid size setting. So, if you have fewer
icons on-screen, folders will also contain fewer icons. If you already have a
folder packed full of app icons in Launchpad (such as the Other folder), OS X
automatically fixes things by creating additional folders as overflow for the
remaining app icons (usually with numbers affixed to the end, such as Other
1, Other 2, and so on).

Note that this tweak also adjusts the size of the icons in the Add Widgets
component of Dashboard—a small side effect.

Enlarging the Icons

Let’s say you want to change the grid size to four rows by four columns of
app icons (see Figure 3, Enlarging the icons within Launchpad), which will
make for significantly bigger icons. Open a Terminal window (open Finder,
select the Applications list, and then in the list of applications double-click
Terminal within the Utilities folder), and type the following two lines, the first
of which refers to the number of icon rows and the second of which refers to
the number of icon columns:

defaults write com.apple.dock springboard-rows -int 4
defaults write com.apple.dock springboard-columns -int 4;killall Dock

Then activate Launchpad to see the changes.
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Figure 3—Enlarging the icons within Launchpad

Shrinking the Icons

To make the icons smaller, we simply increase the grid size. Increasing the
grid size to 10x10 icons will shrink the icons significantly into a compact
layout but still leave them usable. It can be done as follows by typing these
two lines into a Terminal window:

defaults write com.apple.dock springboard-rows -int 10
defaults write com.apple.dock springboard-columns -int 10;killall Dock

Experiment with the settings until you find something you like, but be aware
that each time you reduce the number of rows and columns, you’re also
reducing the number of app icons in each Launchpad folder and possibly
creating overflow folders.

Restoring Default Icon Sizes

To restore the default grid size in Launchpad, again open a Terminal window,
and type the following two lines:

defaults delete com.apple.dock springboard-rows
defaults delete com.apple.dock springboard-columns;killall Dock

Once you do this, you might notice that all your icons are spread out across
various pages within Launchpad. This is a side effect caused by making icons
bigger. You can either drag and drop them back into place or simply issue
the following command in a Terminal window, which will reset Launchpad to
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the default values (although also deleting any Launchpad folders you’ve
created):

defaults write com.apple.dock ResetLaunchPad -bool TRUE;killall Dock

Tip 2

Turn Off Irritating “Rubber-Band” Scrolling

You might have noticed that if you scroll to the top or bottom of a document
or web page within some OS X apps like TextEdit, the page continues to scroll
a little into a boundary area, before springing back. This is known as rubber-
band scrolling and, depending on your point of view, can be rather annoying.

Deactivating Rubber-Band Scrolling in Most OS X Apps

To turn it off in most applications, all you need to do is open a Terminal
window (open Finder, select the Applications list, and then in the list of
applications double-click Terminal within the Utilities folder), and type the fol-
lowing, before logging out and back in again:

defaults write -g NSScrollViewRubberbanding -int 0

To reactivate rubber-band scrolling, should you ever want to, again open a
Terminal window, and type the following:

defaults delete -g NSScrollViewRubberbanding

Log back out and in again for the changes to take effect.

Deactivating for iTunes

The previous method works for most OS X apps, although Safari and iTunes
are two exceptions. It appears it’s impossible to turn it off in Safari, but you
can disable rubber-band scrolling iTunes by quitting the iTunes if it’s open
and then opening Terminal and typing the following:

defaults write com.apple.iTunes disable-elastic-scroll -bool YES

Should you decide you’d like to reactivate rubber-band scrolling in iTunes,
you should quit the app and then use the following command within Terminal:

defaults delete com.apple.iTunes disable-elastic-scroll
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Tip 3

Stop Scrollbars from Disappearing

In recent versions of OS X, the once reliable notion of scrollbars appearing
at the right and (sometimes) bottom of the screen has seen some attention
from Apple’s software engineers.

In OS X Mountain Lion the scrollbars are invisible unless you scroll the doc-
ument or simply place two fingers on the trackpad. This leaves those who
like to click and grab the scroller in the lurch, because if you move the mouse
cursor to where the scrollbar usually is, there’s nothing there—both the ver-
tical and horizontal scrollbars (if the window has one) remain invisible!

Within System Preferences (Apple menu→System Preferences), you can opt
to always have the scrollbar always visible—click the General icon, and select
Show Scroll Bars. This is certainly a solution but not an elegant one.

Viewing Scrollbars When the Cursor Hovers Over Them

Luckily there’s a secret setting that allows the best of both worlds—it will
cause the scrollbars to appear when your mouse cursor hovers over the edge
of the window (or bottom, if the document you’re viewing scrolls horizontally).
Otherwise, the scrollbars be invisible unless you’re scrolling through the
document, as mentioned earlier.

To activate the secret setting, open Terminal, and type the following:

defaults write -g NSOverlayScrollerShowOnMouseOver -bool TRUE

Then log out and back in again for the changes to take effect. Note that if this
doesn’t seem to work and you’re using a standard PC mouse, you might also
have to switch the Show Scroll Bars setting in System Preferences, as men-
tioned earlier, to When Scrolling.

Deactivating Scrollbars-on-Hover

To deactivate the new feature, again open a Terminal window, and type the
following:

defaults delete -g NSOverlayScrollerShowOnMouseOver

Then log out and back in again for the changes to take effect.
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Tip 4

Make Your Mac Speak with Siri’s Voice

At the time of this writing, the iPhone tool Siri hasn’t yet been integrated with
OS X (although OS X has a dictation tool that you can activate via the Dicta-
tion & Speech component of System Preferences). However, you can install
Siri’s voice files to OS X Mountain Lion and use its built-in speech tools to
have the Siri voice talk to you upon request, such as reading aloud highlighted
text.

Activating the Siri Voice Files

Here are the steps needed to switch to the Siri voice files:

1. Open System Preferences (Apple menu→System Preferences), and click
the Dictation & Speech icon.

2. When the Dictation & Speech pane appears, click the Text to Speech tab.

3. Click the System Voice drop-down list, and select Customize.

4. In the drop-down dialog box, scroll down and select Samantha, which
will be under the English (United States) heading. Then click OK. (If you’re
British, you might want to select the Daniel voice under the English
[United Kingdom] heading to get the default British Siri voice; Australian
users should select Karen under the English [Australia] heading.)

5. You’ll be asked if you want to download and install a new voice. Agree to
do so.

6. The voice will now be downloaded and installed, although be aware that
it’s almost half a gigabyte in size so might take some time to come down
the line. Once it’s finished, select it within the System Voice drop-down
list within System Preferences.

Testing the New Voice

You can test the new voice within Safari or TextEdit by highlighting a para-
graph of text and then clicking Edit→Speech→Start Speaking. Note that it
takes a few seconds for Speech to start the first time you use it, and you
might have to quit and restart the app in question for the new voice to start
working. See also Tip 290, Make Your Mac Speak, on page ?.
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Under the Dictation & Speech heading of System Preferences, you can activate
other spoken helpers, such as speaking dialog boxes when they appear. These
are primarily designed to help the partially sighted or blind, but they can be
fun to play around with!

If you get tired of the Siri voice, you can switch to any of the other voices
using the System Voice drop-down list, as described earlier. The default voice
is Alex.

Tip 5

Supertip: Dictate Like a Pro

OS X Mountain Lion includes speech recognition, which you can activate by
opening System Preferences (Apple menu→System Preferences), selecting
Dictation & Speech, and clicking the On radio button on the Dictation tab.

Using it is very simple—just tap the Fn  key twice (or one of the Control  keys if
you’re using a full-sized external keyboard) and then speak. Double-tap the
key again when you’ve finished.

Specifying Capital Letters, Spacing, and Line Breaks

Here’s how to specify capitalization when dictating:

• Capitalizing a word: Say “cap” before the word you to capitalize. For
example, to enter the phrase “We should all read the good Book,” you
would say, “We should all read the good cap Book.”

• Using title case (capitalizing the start of each word): Say “caps on” before
the words you want in title case and then say “caps off” after. For example,
for the phrase “The Town of Bath is Lovely in Spring,” you’d say “caps on
the town of bath is lovely in spring caps off.”

• Block capitals: To capitalize an entire word (the equivalent of using Caps Lock
when typing), say “all caps.” For the phrase “I need the report RIGHT NOW,”
you’d dictate “I need the report all caps on right now all caps off.” An individ-
ual word can be put in capitals by just saying “all caps” before it: “I need the
report all caps now and not later” produces “I need the report NOW and not
later.”
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• All lowercase: To dictate words without any capitalization whatsoever,
use “no caps” in the same way as described for “all caps.” Dictating “I
want to live in no caps on new york no caps off” produces “I want to live
in new york.”

• Prevent hyphenation: OS X’s Dictation feature is clever enough to
hyphenate words that need it, but you can stop it from doing so by saying
“spacebar”: “This is a low spacebar budget enterprise” will produce “This
is a low budget enterprise.”

• Force hyphenation: Should you say something you think should be hy-
phenated but OS X’s Dictation doesn’t realize, you can simply say “hyphen”
—“He was a no hyphen good man” will type “He was a no-good man.”

• Remove spaces altogether: To create a sentence or series of words without
spaces between them (compounding words), use “no space.” As with the
dictation terms earlier, it can be used singularly to indicate two words
should be joined, or it can be turned “on” and “off” before and after a
series of words: “We are best no space friends” will type “We are best-
friends”; saying “We are no space on best friends forever no space off” will
type “We are bestfriendsforever.”

• Inserting line breaks: To insert a line break, just say “new line.” To insert
a paragraph break (that is, an empty line before the following sentence),
just say “new para.”

Specifying Punctuation, Symbols, and Numerals

In most cases, inserting punctuation is intuitive and obvious. Saying “full
stop” or “period” will insert that symbol, for example. Saying “copyright sign”
will insert a copyright symbol, and saying “at sign” will insert @. Saying
“inverted question mark” will produce the ¿ symbol.

OS X will automatically insert “curly quotes” but if you specifically want a
noncurly quotation mark, say “backquote.”

Currency symbols, including the dollar, must be followed by “sign” if not used
with numbers: to say “$31” you can simply say “thirty-one dollars” but to
type “We need more $,” you would have to say “We need more dollar sign.”

You can also insert a long dash by saying “em dash.” To insert ellipsis (…),
say either “dot dot dot” or “ellipsis.”
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Should you want to use Roman numerals, just say them as you would nor-
mally preceded by numeral: “The year of my birth was numeral MCMLXXII.”
Similarly to inserting an actual number rather than the word for the number
(that is, “5” rather than “five”), say “numeral” beforehand: “He reported there
were numeral five of them" will type “There were 5 of them.”

Inserting Emoticons

What if you want to indicate your vague emotional state via clever use of
punctuation? Apple has thought of that. Simply saying “smiley face,” “winky
face,” and “frowny face” will insert :-), ;-), and :-(, respectively.

Navigating Around Text

Although navigating the cursor through text is best done via the keyboard or
mouse, the dictation tool offers two commands to move the cursor: “next line”
will move the cursor to the next line of text, while “next paragraph” will move
it to the next paragraph.

Tip 6

Get Rid of Files—Securely

Whenever you empty the trash, the files are deleted in the standard way; that
is, the OS X filesystem makes the space they occupied available for another
use. However, the actual content of the files sticks around on the disk until
it’s overwritten, and it can be recovered using one of the many third-party
file recovery tools available.

To avoid this, you can securely empty the trash, which involves writing over
the data with zeroes so that it can’t be recovered (at least outside of a high-tech
crime lab), but bear in mind that the files might still exist in your Time
Machine backup (see Tip 307, Make Time Machine Forget a File, on page ?).

Note that if your Mac has a solid-state hard disk (SSD), such as those fitted
to MacBook Air and Retina MacBook Pro computers, securely erasing files or
the trash in the ways described next is ineffective and likely unnecessary
because SSDs employ TRIM to clean up old data.1 The best method of protect-

1. See http://arstechnica.com/security/2011/03/ask-ars-how-can-i-safely-erase-the-data-from-my-ssd-drive/,
although if you’ve fitted a third-party SSD to your Mac, see also http://www.groths.org/
?page_id=322.
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ing an SSD (or any kind of storage disk) from data snoops is to encrypt its
contents—see Exploring OS X: FileVault, on page ?.

Securely Emptying the Trash

To securely empty the trash, simply click and hold the trash icon in the Dock
until the context menu appears (or right-click the Dock icon). Let go of the
mouse button and then hold down the Command  key. The menu will change
to read Secure Empty Trash. Click to do so. You can also open a Finder win-
dow and click the Secure Empty Trash entry on the Application menu.

Be aware that deleting files securely takes significantly longer than deleting
unsecurely. With a very full trash can, it might take hours. The work of
securely emptying the trash will take place in the background, however.

Always Emptying the Trash Securely

To always securely empty the trash, open a Finder window and click the
Application menu and then Preferences. Then click the Advanced tab, and
check Empty Trash Securely.

Wiping Individual Files

While there’s no built-in method of securely obliterating individual files on
the desktop, short of moving them to the trash and then selecting to securely
empty it, you can use the command-line tool srm to delete files and then
overwrite the space with random data. srm is perhaps one of the most danger-
ous commands available on your Mac, however, so use it carefully!

Next I explain how to use it at the command line, before explaining how it
can be used to create a simple Automator service for use in Finder windows
and on the desktop.

Using srm at the Command Line

Open Terminal (open Finder, select the Applications list, and then double-
click Terminal in the Utilities folder), and at the command prompt type srm.
Then drag and drop from a Finder window onto the Terminal window the file
you’d like to eradicate. For example, if I wanted to delete file.txt from my
desktop, after I’d dragged and dropped it onto the Terminal window, I’d see
the following:

srm /Users/keir/Desktop/file.txt

Then hit Return  to complete the command and eradicate the file. As with all
Terminal commands, if you see no output, then everything has worked fine.
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Depending on the size of the file, deletion should take no more than a few
seconds.

The srm command is intended to be a secure version of the basic rm Unix
command. Therefore, securely deleting a directory and its files can be achieved
with srm -rf followed by the directory name and path. However, when deleting
many files in this way, it’s useful to add the -v (verbose) switch so you get a
progress display and can confirm when each file is deleted. In other words,
the command for deleting a directory would be srm -rfv .

Creating a GUI Secure Delete Tool

Using Automator you can create a service that appears on the menu that
appears whenever you right-click a file and offers a secure delete function
powered by srm. Here’s how to set it up:

1. Start Automator, which you’ll find near the top of the Applications listing
within Finder. When it starts, click the Service icon within the Choose a
File Type For Your Document dialog box, and then click the Choose button.
If this dialog box doesn’t appear, click File→New.

2. In the Automator program window, click in the search field above the
second column from the left, and type Run Shell Script. This will filter the list
beneath to one item, which you should drag to the right side of the pro-
gram window, dropping it over the area containing the text Drag Actions
or Files Here to Build Your Workflow.

3. At the top right of the window, alongside the heading Service Receives
Selected, you’ll see two drop-down lists alongside each other: Text and
Any Application. Change the first to Files or Folders and the second (on
the right) to Finder.

4. Under the Run Shell Script heading, change the Pass Input drop-down
to As Arguments.

5. In the large text area beneath the Run Shell Script heading, delete what’s
already there, and type the following; for an example from my test system,
see Figure 4, Creating a secure delete GUI tool:

for i in "$@"
do
srm -rf "$i"
done
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Figure 4—Creating a secure delete GUI tool

6. Click File→Save. Because this is a service, there’s no need to specify a
destination for the file. However, you will need to type a filename. This is
what will appear in the menu when you right-click files, so something
illustrative like Secure Delete will do. Click the Save button in the dialog
when you’re done.

7. Once the service has been saved, you can quit Automator.

You can now test your new service—right-click a file/folder (or a selection of
them), and select Secure Delete from the menu. Alternatively, you may have
to click Services→Secure Delete. After a few seconds, the file or folder will
simply disappear and will be gone forever (it won’t go to the trash!).

Bear in mind two things: first, there’s no status update when deleting files
this way, and second, large files or large collections of files might take some
time to be deleted. Deleting will take place in the background, so, once
started, you can get on with other things.

Also bear in mind as mentioned earlier that there’s no way to undo file/folder
deletion that’s done this way—it’s an extremely thorough way of eradicating
data!

To remove your Secure Delete service, open a Finder window, and hit
Shift+Command+G . In the dialog box that appears, type ~/Library/Services. Then
drag the Secure Delete service file to the trash. Then log out and back in
again.
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Tip 7

Auto-answer FaceTime Calls

Here’s a neat tip that enables the FaceTime app to automatically answer
incoming calls from contacts you specify. You can use it if you’re happy having
calls from specified colleagues, friends, or family automatically answered,
although be careful because there’ll be nothing stopping these incoming
callers from instantly seeing what’s happening in front of your computer!

Enabling Auto-answer on FaceTime

Here are the steps required to enable automatic answering of calls on Face-
Time:

1. Start by opening FaceTime if it isn’t already open, and log in. Then look
for the contact details of the individual(s) you’d like to enable auto-
answering for. This will be listed in your Contacts or Favorites list and
will probably be an email address. Write the details down, and then quit
FaceTime.

2. Open a Terminal window (open Finder, select the Applications list, and
then in the list of applications double-click Terminal within the Utilities
folder), and type the following line:

defaults write com.apple.FaceTime AutoAcceptInvites -bool TRUE

3. Then type the following line, and at the end type the FaceBook ID of the
individual or device you want to auto-answer when they call. For example,
if the contact FaceTime ID is keir@example.com, you’d type the following:

defaults write com.apple.FaceTime AutoAcceptInvitesFrom -array-add
keir@keirthomas.com

If the FaceTime ID is a cell phone number, you need to type it after the
command without any spaces. For example, if the FaceTime ID was the
cell phone number +1 555 123 1234, you’d type the following:

defaults write com.apple.FaceTime AutoAcceptInvitesFrom -array-add
+15551231234

Restart FaceTime, and you should find calls from the FaceTime IDs you added
are automatically answered!

You can repeat step 3 and add more FaceTime IDs to the list.

• 16

• Click  HERE  to purchase this book now.  discuss

http://pragprog.com/titles/ktmack2
http://forums.pragprog.com/forums/ktmack2


Removing Auto-answer Entries

To remove a FaceTime ID from the auto-answer list, you can use the following
command, but unfortunately this removes all of the entries you might have
added using the previous commands.

Quit FaceTime, open a Terminal window, and type the following two lines:

defaults delete com.apple.FaceTime AutoAcceptInvites
defaults delete com.apple.FaceTime AutoAcceptInvitesFrom

If you have Xcode installed and are competent using its Plist editor, you can
manually remove individual auto-answer entries from the FaceTime prefer-
ences file, which is found in the ~/Library/Preferences/com.apple.FaceTime.plist file.

Tip 8

Instantly Add Movies and Music to iTunes

If you use third-party software to download music and movies to your com-
puter, you’ll be familiar with the rather lengthy process needed to add them
to your iTunes library—you have to start iTunes, then ensure the correct
music or movie list is visible, and finally drag and drop the files onto the
program window….

However, there’s a hidden folder you can use to import music and movies
straight into iTunes. All you need to do is configure any app you use to
download files straight into this folder, and they will be instantly imported—
even if iTunes isn’t running at the time.

To find the folder, open Finder, hit Shift+Command+G , and then type
~/Music/iTunes/iTunes Media/. One of the folders you should see will be Automatically
Add to iTunes. As its name suggests, any files copied into this folder will be added
to iTunes automatically. Assuming you have kept the default preferences
setting of iTunes organizing your media folders, any files placed there will be
moved out of the folder and automatically filed within the Music folder whenever
iTunes is running, so it should appear empty most of the time.

You can create a desktop alias of the folder by clicking and dragging it to the
desktop, before pressing Option+Command and releasing the mouse button. You
can then simply drag and drop files onto the alias instead.
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Tip 9

Be a Messages App Keyboard Wizard

Because the Messages app is all about typing and because reaching for the
mouse or trackpad can be a distraction, keyboard shortcuts are essential.
Here are some of the more useful:

DescriptionShortcut

Set your status as available (A ), invisible ( I ), away
(W ), or offline (O ).

Control+Command+A/I/O/W

Show buddies list.Command+1
Move between conversations listed on the left of
the Messages window (if two or more conversations
are listed).

Control+Tab

Cycle through things you’ve already typed and sent
—useful if you need to repeat something said ear-

Option+Up/Down

lier in the conversation. Hit Return  to resend the
message.

Show the entry within Contacts of the person
you’re chatting to; if they have no entry within your
address book, you’ll instantly create a new one.

Option+Command+B

Show profile details of the person you’re chatting
to, and set audio alerts/bounce the Messages icon

Shift+Command+ I

in the Dock/run an AppleScript when they perform
various actions, such as come online or send you
a message.

Compose a new email to the individual in Mail,
provided an email address is associated with the
individual’s IM chat account.

Option+Command+E

Show a list of recent and ongoing file transfers (to
transfer a file, drag and drop it onto the conversa-

Option+Command+L

tion within the Messages window, or hit
Option+Command+F  to open a dialog box where you
can select a file).

Add a timestamp to the conversation, similar to
that which appears when you initially go online

Shift+Command+K
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DescriptionShortcut

and start chatting with somebody—useful if you
want to record when something was said.

Permanently delete conversation—cannot be
undone.

Option+Command+K

Open video effects window so you can apply special
effects to any video conversation (click the camera

Shift+Command+E

icon at the top right of the chat window to start
video conversation; note that Messages doesn’t
support video calls on all chat protocols).

Tip 10

Store Absolutely Any File in iCloud

The built-in Preview app lets you add images and PDFs to its iCloud store
(click File→Open to add files), which are what the app usually displays on
most Macs, but that’s not all it’ll accept for upload. It’ll also store (and let you
view!) Microsoft Office documents, such as Word, Excel, and PowerPoint files.
Strangely, however, it won’t accept more primitive office document formats
such as rich-text files (those with an .rtf extension) or comma-separated value
spreadsheets (those with a .csv extension).

It’s worth bearing in mind that, just like with Finder windows, you can hold
down Option  to copy a file to iCloud, rather than moving it there, which is the
default behavior.

Note that the range of image files Preview will accept for upload to iCloud is
very broad—you can save Photoshop (.psd) documents there, for example, and
view them within Preview.

TextEdit accepts any kind of file for upload to its iCloud storage area—from
MP3 files and movies to images—even though it can’t open them (attempting
to open, say, a movie will produce a screen full of seemingly random charac-
ters, although you can still watch the movie in Quick Look by selecting it in
the iCloud listing and hitting Space ).

TextEdit’s egalitarian approach to iCloud makes it an ideal way of transferring
files from one Mac to another via iCloud, provided they’re both logged in to
the same iCloud ID—just drag and drop the file onto the TextEdit window of
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the first computer, and then drag and drop it from TextEdit’s iCloud listing
to a Finder window on the other Mac.

Tip 11

Use a Secret, Alternative Cut and Paste

Ever had something important held in the clipboard, like a picture, yet
wanted to quickly cut and paste some text within a document? OS X actually
contains two clipboards, although the second is much more primitive than
the main one and will cut and paste only text. You won’t find it on any menus,
either, and it is available only via two keyboard shortcuts. You can use it in
the usual way by highlighting some text, using Control+K  to cut the text, and
pressing Control+Y  to paste the content in the new position. (Note that’s Control
and not Command ; longtime Unix/Linux users will, of course, recognize this
secondary clipboard as an implementation of the kill and yank tools found
in the likes of Emacs.)

There’s no “copy” option, unfortunately, although you can emulate this by
cutting the text with Control+K  and then immediately pasting it back in with
Control+Y , before moving to the new position where you’d like the text to be
inserted and again pasting with Control+Y .

Only plain text is copied—any formatting such as bold or italics is lost.
Additionally, although it should work fine within most OS X applications, it
probably will not work if you cut text from one app to paste into another app
—in my testing, each app seemed to have its own private secondary clipboard.
However, the only way to find out for sure is to give it a try!

Tip 12

Correct Misspellings or Typos Without the Mouse

Although in many OS X apps you can right-click a misspelled or mistyped
word to see suggested replacements (that is, words that are underlined in red
or blue), you can also simply move the cursor to the end of the word using
the cursor keys and then wait a second until a list of suggested replacements
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appears beneath. Hit the Down cursor key and then the Left/Right cursor
keys to select a replacement, before hitting Return  to select the one you’re
happy with (or hit Esc  to quit the replacements menu). If no list appears, it’s
probably the case that OS X has no suggestions for that particular misspelling
or typo.

Tip 13

Create iCloud Folders

Here’s a tip that will be obvious to anybody who owns an iPad or iPhone but
possibly a revelation to anybody else.

Apps that let you save files within iCloud, such as TextEdit and Preview, allow
you to create folders within iCloud to help organize documents. But there’s
no New Folder button. Instead, you can create a new folder by dropping one
file on top of another (provided either file isn’t locked). You’ll immediately be
prompted to enter a name for the new folder. Simple!

You can add new items to the folder by dragging and dropping them on top,
just like in Finder. Note that you can also elastic-band select many files at
once.

To delete the folder, you’ll need to empty it of all its contents by either dragging
the files out or deleting them. Then the folder will vanish.

Note that there are a couple of caveats. First, iCloud folders aren’t like those
on your hard disk because you can’t create another folder within them. All
each folder can contain are files. Second, note that any file that’s locked (see
Tip 199, Lock Files for Safety, on page ?) can’t be added to an iCloud folder
until it’s unlocked.
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Tip 14

See What Folders You’ve Accessed Recently

Want to see a list of folders or places you’ve recently accessed in Finder? Just
click and hold the back button at the top left of the Finder window. In the list
that appears, you can click any of the folders to jump straight to that location.

You can also click and hold the forward button to select one of the folders or
places later in your history—in other words, that you previously visited after
visiting that folder! (Note: This also works in most web browsers, where
clicking and holding back or forward will show a list of your most recently
accessed websites.)

Tip 15

See Bluetooth Signal Strength

If you use any Bluetooth devices with your Mac, such as a keyboard or mouse,
there are a variety of ways you can view the strength of the signal between
your Mac and the device(s).

Using System Preferences to View Signal Strength

To get the most information, you can use System Preferences (Apple menu→
System Preferences). Once it’s open, click the Bluetooth icon, and then select
the Bluetooth device in the list while holding down Option—see Figure 5,
Viewing the signal strength of a Bluetooth peripheral, on page 23. You’ll see a
number along with a familiar signal bar display that you might be used to
with your cell phone or Wi-Fi signal.

As with similar displays, five bars is the maximal signal strength, while one
bar indicates a weak and potentially unstable connection (the solution is to
move the Bluetooth device closer to the Mac or to remove any objects that
might be obscuring your Mac or the device, especially those that are metal).
To get an updated signal reading, repeatedly click the Bluetooth’s entry in
the list while holding down Option .
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Figure 5—Viewing the signal strength of a Bluetooth peripheral

The number corresponds directly with the bar display and shows the power
ratio (dBmW) of the signal. A smaller number indicates a stronger signal—in
my test -40 equated to a strong five-bar signal, while -70 equated to a poor
signal strength of one bar.

Quickly Viewing Signal Strength on the Desktop

Another way to view signal strength that doesn’t use System Preferences is
as follows: hold down Option  while clicking the Bluetooth icon at the top right
of the screen, before moving the mouse down the menu showing all connected
devices (you can release Option  after clicking the Bluetooth icon). Here you’ll
see not only the power ratio figure mentioned earlier but also battery life (in
the case of Apple peripherals) and other technical details, such as the MAC
address of the Bluetooth device.

Monitoring Signal Strength Over Time

To monitor signal strength over a period of time, which can be useful when
diagnosing connection problems, return to the Bluetooth pane of System
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Preferences, and select the device you want to monitor in the list. Then hold
down Option  before clicking the cog icon beneath the list of Bluetooth devices,
and select Monitor Connection RSSI from the menu that appears. This will
open a new window showing a graph of connection strength, updated every
few seconds continuously until you click the Close button at the bottom right.

Tip 16

Switch to Black Menus in Full-Screen Mode

Here’s a small secret tweak that will make the menu bar at the top of the
screen turn black whenever you enter full-screen mode with any application.
It brings no new functionality other than altering the appearance of the menu.

Open a Terminal window (open Finder, select the Applications list, and then
in the list of applications double-click Terminal within the Utilities folder), and
type the following:

defaults write -g NSFullScreenDarkMenu -bool TRUE

Then log out and back in again. Switch any compatible app to full-screen
mode (click the arrow at the top right of the window or click View→Enter Full
Screen), and then push the mouse against the top of the screen to see the
now-blackened menu bar appear.

To switch back to the standard gray tint menu, again open a Terminal window,
and type the following:

defaults delete -g NSFullScreenDarkMenu

Log out and back in again for the changes to take effect.

Tip 17

Create Reminders Ultra-Quickly

Imagine the situation: you receive an email from a friend reminding you to
pick up a book for him from the bookstore. Being a Mac OS X user, you know
exactly how to handle the situation: you can add an entry in the Reminders
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app, which will then be shared with your iPhone, iPod touch, and iPad. No
more forgetting!

There’s just one problem: starting Reminders and then creating the actual
entry on the list is a lot of effort and far from the casual single-click we might
expect of Apple technology.

There are two solutions to this terrible problem, as follows.

Dragging and Dropping to the Reminders App

If the mail you’ve received has as its subject line the nature of the reminder
(e.g., “Don’t forget to pick up the book!”), you can drag and drop the email
from the list within Mail to the Reminders icon on the Dock, or you can drag
and drop the email on top of the Reminders program window if it’s open. This
will instantly create a new reminder named after the subject of the mail, and
you’ll even be provided with a link to the original email within the reminder
(click Show in Mail).

If anybody has replied to the original email or if it’s part of a series received
from the sender, then this trick needs a little modification—click the email
in the list so it’s visible in the preview pane on the right side of the Mail win-
dow. Then move the mouse cursor over the left side of the email preview, near
the Subject and Reply-To headings. The cursor will change to a hand grabber.
You can then click and drag the mail to the Reminders app, as described
earlier.

Adding a “Create Reminder” Entry to Right-Click Menus

As easy as drag and drop is, wouldn’t it be handy just to be able to select the
text in the email (i.e., “pick up the book from the store”), then right-click, and
select a menu option that will instantly create a Reminders entry—even if
Reminders isn’t running? This function isn’t built into OS X but can be easily
created and will work in almost any app. The following are the necessary
steps, although there are actually two methods—the first will simply add a
reminder without prompting you for any details, while the second will pop
up a dialog box wherein you can select which Reminders list to use, the
reminder’s priority, and its due date.

Creating a Simple Reminders Service

Here’s how to create the first of the options mentioned earlier—a simple right-
click option that will instantly create a new reminder in the default list based
on the text you select:
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1. Open Automator, which can be found in the Applications view of Finder.
If the new file dialog doesn’t appear, click File→New. In the Choose a Type
For Your Document dialog box, select Service (the cog icon), and then
click the Choose button.

2. In the search field above the list of actions within the Automator program
window, type New Reminders Item. Click and drag the only item in the list
(which will also read New Reminders Item) to the right side of the
Automator window, over the text Drag Actions or Files Here to Build Your
Workflow.

3. Leave everything blank. All you need to do is click File→Save and then
type a name for your new service in the Save Service As dialog box. This
is what’ll appear in the right-click menu, so something like Create Reminder
is fine (there’s no need to choose somewhere to save the service because
they’re automatically saved in the correct location). Then you can quit
Automator.

You can try your new service straightaway. Just highlight some text, right-
click it, and select Create Reminder (or Services→Create Reminder if there’s
no Create Reminder option on the menu). If Reminders is running, you’ll see
the entry has been added, but even if it isn’t, the entry is still added, as you’ll
find when you next start the app.

Creating a Pop-up Dialog Box Service

Here’s how to create a service similar to the one earlier except when you select
Create Reminder from the right-click menu, a dialog box will pop up each
time to let you set options such as which reminder list will be used, its prior-
ity, and due date.

1. Follow steps 1 and 2 earlier so that the basic New Reminders Item
automator service is in place. However, click the Options link at the bottom
of the service.

2. Check the box Show This Action When The Workflow Runs; then check
Show Only The Selected Items.

3. You will now see a checkbox alongside each item of the service. Check
everything, except the Title field. You should end up with something that
looks like Figure 6, Creating a service to create new reminders. Now repeat
the earlier step 4 to save the new action.
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Figure 6—Creating a service to create new reminders

Test our new service by highlighting some text, right-clicking it, and selecting
Create Reminder (or Services→Create Reminder if there’s no Create Reminder
option on the menu). A dialog box should appear letting you set various
options, such as which of your Reminders lists to add the new reminder to.
Select from them, and click the Continue button. (Note that, on my test Mac,
the first time I used this new service, an additional dialog box popped up
asking if the app could access my contacts; I assume this is a bug, but
agreeing to it will do no harm.)

If Reminders is running, you’ll see the entry has been added—complete with
the attributes you set—but even if it isn’t, the entry is still added, as you’ll
find when you next start the app.

Removing the Menu Entry

To remove the service, should you want to, open Finder, and then hit
Shift+Command+G . In the dialog box that appears, type ~/Library/Services, and hit
Return . Then drag the service you created to the trash. Log out and back in
again to complete the removal.
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Tip 18

Right-Click to Share Anything

OS X Mountain Lion features Share Sheets, which are buttons at the top of
certain program windows (including Finder) that allow you to instantly share
things via Twitter, email, Facebook, and Messages or to AirDrop what you’re
viewing or working on (provided accounts for these services are set up within
the Mail, Contacts & Calendars component of System Preferences, of course).

However, you can also right-click just about anything to share it in this way
—right-click an image file on the desktop, for example, and you can select
the Share option on the menu to instantly tweet or post it to your Facebook
wall. This works in Finder windows too, where you can share any file via
email, AirDrop, and Messages. Highlight some text (and/or images) within
TextEdit before right-clicking it, and the same Share option will appear on
the menu, allowing you to send just the highlighted text to your Twitter or
Facebook accounts (if they Send button is grayed out and you’re attempting
to tweet something in this way, it might be because you’ve exceeded the 140-
character limit!).

Tip 19

View Safari’s Google History

To see a list of your recent searches in Safari, click in the Address and Search
bar, delete what’s there, then either click the magnifying glass icon at the left
of the Address and Search bar or simply hit Space . The previous searches will
appear in a list beneath, along with some recent history. You can jump
between headings in the list using the keyboard by holding down Command
and pressing the Up/Down cursor keys.

You can also quickly switch to an alternative search engine by selecting it
from the bottom of this drop-down list. Your new search engine choice will
remain in place until you again select a different choice—even after you restart
Safari.
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Tip 20

Open a Link Displayed in Terminal

If you see a web or email link within a Terminal window (in a man page, for
example), simply hold down Command  and then double-click it. The link will
instantly open in your usual browser or email client, such as Safari or Mail.

For what it’s worth, this will work even if you simply type an address into a
Terminal window, even if it isn’t preceded with http://.
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